
Create a movie or Hollywood-style trailer. To get started with a project, click  in the Projects pane,
then choose Movie or Trailer. When you choose Trailer, select a template, then click Create.

Add media from your photo library. Photos and video clips in your Photos library are automatically
available for use in iMovie. In a project, select your photo library in the iMovie sidebar, choose the photo or
clip you want to use to see a preview in the viewer, then drag it to the timeline to add it to your project.
iMovie creates a new library and event for you.

You can also import video from your iPhone or iPad, from a camera, or from media files already on your
Mac.

Record video in iMovie. Use the FaceTime HD camera on your Mac to record video and add it to your
project. Select an event in the sidebar, click Import in the toolbar, select FaceTime HD Camera, then click the
Record button to start and stop recording.

Tip: Shooting video with a handheld device can produce shaky results, but you can stabilize the video so the

playback is smoother. Select the clip in the timeline, click , then click Stabilize Shaky Video.

Learn more. See iMovie User Guide and iMovie Support.

Watch and listen with Music, Podcasts, and TV
Your MacBook Pro offers built-in apps that provide hours of entertainment and sync with your other Apple
devices when you’re signed in to the same Apple Account.

help:openbook='com.apple.iMovie.help'
https://support.apple.com/imovie


Music

Listen to your favorite tunes from
your personal library or subscribe to
Apple Music to listen ad-free to over
100 million songs and 30,000
playlists.

Get started with Music

TV

Watch all your movies and TV
shows in the Apple TV app. Buy or
rent movies and TV shows or
subscribe to additional channels or
services.

Get started with TV

Podcasts

Listen to your favorite shows—
from big names to independent
publishers, discover your next
favorite, or subscribe with
Podcasts.

Get started with Podcasts

Music

The Apple Music app makes it easy to organize and enjoy your iTunes Store purchases, songs, and albums. In
addition to your personal library, you can also subscribe to access the Apple Music catalog, which lets you
listen to millions of songs on demand and immerse yourself in lossless and Spatial Audio.

If you haven’t already, sign in to your Apple Account to get started.

Subscribe to Apple Music. Go to the Music app, choose Account > Join Apple Music, then follow the
onscreen instructions.

Note: If you don’t see Join Apple Music, you may already be subscribed with Apple One or with a Family
Sharing Plan.

Search for songs, albums, playlists, and more. In the search field, type what you’re looking for, such as an
artist, song, or album. Results are grouped in categories such as Artists, Albums, Songs, and Music Videos. If
you want to search just your library, click Your Library at the top right.



Buy songs or albums. If you want to own your music, search for the song or album you want to buy. Click

iTunes Store at the top right, then click the price listed below the album or beside the song. Or click  on
a song or album, then choose Show in iTunes Store.

Add items to a playlist. To add a song to a playlist, Control-click an item, choose Add to Playlist, then
choose a playlist—or choose New Playlist to start a new playlist with your selection.

Siri: Say something like “Play the playlist, Olivia’s Favorites.”

Learn more. See the Music User Guide.

TV

Watch all your movies and TV shows in the TV app. Buy or rent movies and TV shows, subscribe to
channels, and pick up where you left off watching from any of your devices.

If you haven’t already, sign in to your Apple Account to get started.

Subscribe to Apple TV+. Apple TV+ is a subscription streaming service featuring Apple Originals—award-
winning films, series, compelling dramas, groundbreaking documentaries, kids’ entertainment, comedies, and
more—with new items added every month. To subscribe, click the Apple TV+ tab in the Apple TV app, then
click Subscribe. You may be eligible for a free trial, in which case, click Access Free Trial.

Note: Availability of Apple TV+ may vary by country or region. Learn what’s available in your country or
region.

Search for shows or movies. In the search field at the top-left corner of the TV app, type the name of a show,
movie, or actor, then press Return. Search results are grouped into Top Results, Movies, and TV Shows. Not
sure what you’re looking for? Browse the Home, Apple TV+, or Store tabs to discover new shows and
movies.

help:openbook='com.apple.Music.help'
https://support.apple.com/118205


Buy or rent. When you find a movie or TV show you want to watch, you can choose to buy or rent it in the
Store. To watch purchased or rented content, go to your Library. Channels you’ve subscribed to are available
on all devices, and can be used by up to six family members through Family Sharing.

Pick up where you left off. If you watch Apple TV on other devices, continue watching right where you left
off. Click Home, then choose the content you want to continue from the Up Next row.

Learn more. See the Apple TV User Guide.

Podcasts

Use Apple Podcasts to browse, follow, and listen to favorite podcasts on your Mac. Personal
recommendations help you discover new podcasts grouped by topics you care about.

If you haven’t already, sign in to your Apple Account to get started.

Search for podcasts. Type a podcast’s name in the search field, followed by the Return key to quickly find
your favorites. You can also search by host name, guest, or topic to get a list of shows where they’re
mentioned or discussed.

Play a podcast. Start playing a podcast by moving the pointer over the show or episode you want to play,

then click .

Siri: Say something like: “Continue playing the last podcast.”

help:openbook='com.apple.TV.help'


Follow your favorites. Click Follow to add a show to your favorites so that you never miss a new episode.
See what’s new in the Recently Updated tab of your Library.

Save episodes to your library. To save a single episode to your library, click . To download a podcast for

offline listening, click . When you download podcasts to your device, you can access them on that device
when you’re offline.

Learn more. See the Podcasts User Guide.

Search the web with Safari
Enjoy the internet with blazing fast speed, optimized battery life, and powerful privacy protections built right
in. Safari works seamlessly and syncs your passcodes, bookmarks, history, tabs, and more across all your
Apple devices using the same Apple Account, so you get the same Safari wherever you browse.

help:openbook='com.apple.podcasts.help'


Change your homepage. Make your browser your own by choosing a homepage. Choose Safari > Settings,
then click General. In the Homepage field, enter a webpage address. To simply use the webpage you’re
currently viewing, click Set to Current Page.

Start searching. Start typing a word or website address—Safari shows you matching websites, as well as
suggested websites. Or select a favorite or frequently visited item from your Safari start page.

Simplify reading on the web. Use the smarter, redesigned Reader to view a webpage—such as a recipe,
news article, or blog post—formatted for easy reading, presented without ads, navigation, or other distracting

items. Click  in the Smart Search field, then click Show Reader. When you’re in Reader mode, click 
to change the font and color.



Add and view bookmarks. Save frequently visited websites—favorite stores, online news sites, blogs, and

more—in your bookmarks for quick access. To bookmark the page you’re viewing, click  in the toolbar,

then choose Add Bookmark. To view your bookmarks, click , then select .

Organize with Tabs. Avoid cluttering your desktop with multiple windows. You can instead view multiple

webpages in a single Safari window by using tabs. To open a new tab, click  in the Safari toolbar, or
press Command-T.

Make a purchase with Apple Pay. When you shop online using Safari, you can make easy, secure, and
private purchases on websites using Apple Pay on your Mac. When you choose Apple Pay on a website,
place your finger lightly on the Touch ID sensor on your MacBook Pro. You can also confirm payment using
your iPhone or Apple Watch.

With Apple Pay, your Apple Card and other credit or debit card information is never stored or shared by
Apple with the merchant. For learn more, see the Apple Support articles Set up Apple Pay, Make purchases
using Apple Pay, and Change or remove the payment cards that you use with Apple Pay.

Note: Apple Pay and Apple Card aren’t available in all countries or regions. For information about
Apple Pay, go to Apple Pay. For information about current card issuers, see the Apple Support article
Apple Pay participating banks. For information about Apple Card, see Apple Card Support.

Use Private Browsing. Create a private browsing window by choosing File > New Private Window. When
you use private browsing, Safari won’t remember your history, helps prevent websites from tracking you,
completely blocks known trackers from loading on pages, and removes tracking used to identify you from
URLs as you browse.

To better understand how a site treats your privacy, click   to the left of the active tab to view the cross-site

https://support.apple.com/HT204506
https://support.apple.com/102626
https://support.apple.com/118219
https://www.apple.com/apple-pay
https://support.apple.com/HT204916
https://support.apple.com/apple-card


trackers that Safari is blocking on each website. Click  to see a privacy report with more details about the
website’s active trackers.

Learn more. See the Safari User Guide.

In the U.S., Apple Pay is a service provided by Apple Payments Services LLC, a subsidiary of Apple Inc. In
other countries and regions, Apple Pay is a service provided by certain Apple affiliates, as designated by the
Apple Pay privacy notice. Neither Apple Inc. nor Apple Payments Services LLC nor any Apple affiliate is a
bank. Any card used in Apple Pay is offered by the card issuer.

Design with iWork on Mac
With iWork—Pages, Numbers, and Keynote—you can create amazing documents, spreadsheets, and
presentations on your MacBook Pro. Templates and design tools make it easy to get started. And with real-
time collaboration, your team can work together, whether they’re on Mac, iPad, iPhone, or a PC.

Pages

Use Pages to create any kind of
document you want, from a
simple word-processing document
that’s mainly text, to a page layout
document with graphics,
interesting font treatments, and
more.

Numbers

Create spreadsheets with more than
250 powerful functions and features
to help you visualize and analyze
data. Templates give you a head
start when you create budgets,
invoices, team rosters, and more.

Keynote

Use Keynote to design create
beautiful and engaging
presentations. Choose one of the
more than 30 predesigned themes
and make it your own by adding
text, 3D objects, and changing the
color scheme.

Create documents in Pages, Numbers and Keynote. To get started, open Pages, Numbers, or Keynote,
select New Document, then choose a template or theme or click Blank. Click Create to open the document
and start making changes.

help:openbook='com.apple.Safari.help'
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All your formatting tools, in one place. Click  in the Pages, Numbers, or Keynote toolbars to open the
Format inspector. Select something in your document, and the formatting options for it appear.



Collaborate on documents with iCloud. Work together in real time with iWork. With Activity Stream, a
detailed list in the sidebar allows you to see edits and comments made by collaborators. In a Pages, Numbers,

or Keynote file, click , choose Collaborate, then choose how you want to share the file. You can also
choose to Send a Copy.

Tip: Turn on change tracking to see the changes you and others make to a document. Each person’s edits and
comments are color-coded, so you can see who made each change. Choose Edit > Track Changes to show the
change tracking toolbar.



Learn more. See the Pages User Guide, Numbers User Guide, and Keynote User Guide.

Get more apps
The App Store is your one-stop-shop to find, purchase, and download new apps and games for your
MacBook Pro. You can also get the latest updates, view and manage subscriptions, and more. And all you
need is an Apple Account.

help:openbook='com.apple.iWork.Pages.remote.help'
help:openbook='com.apple.iWork.Numbers.remote.help'
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Sign in to your Apple Account. To download free apps, sign in to your Apple Account. Go to the App Store

app  on your Mac, then click Sign In at the bottom of the sidebar.

Note: To purchase apps, you must also set up an account with purchasing information.

If you don’t have an Apple Account, click Sign In, then Create Apple Account. If you have an Apple
Account, but don’t remember your password, click “Forgot Apple Account?” to recover it.

Get more apps. Apps you download from the App Store appear automatically in Launchpad. In the App

Store app  on your Mac, do any of the following:

Know exactly what you’re looking for? In the search field at the top-left of the window, type the app
name—such as Microsoft Office, Excel, and Powerpoint—then press Return.

Want to explore available apps? Choose a tab in the sidebar—such as Create, Work, or Play—and
browse through the results.

Siri: Say something like: “Find apps for kids.”

Already purchased the app? Click your name on the bottom-left to view your account information,
including a list of previously purchased apps. Apps and subscriptions can be managed in the Purchase
History section of Account settings.

Update apps and games. If you see a red badge on the App Store icon in the Dock, there are updates

available. In the App Store app , click the Updates tab in the sidebar to see available updates, then click



the Update button.

Subscribe to Apple Arcade. Click Arcade to subscribe to Apple Arcade. When you subscribe to Apple
Arcade, you gain access to 200+ fun games, with more added all the time. To learn more about the Apple
Arcade subscription service, see the Apple Support article Play games with Apple Arcade.

Get games. In the App Store, click the Play tab in the sidebar to search and discover games you can
download and play. You can search for a game by typing the name in the search field, then pressing the
Return key. To buy or download the game, click Get or the price next to the game.

Learn more. See the App Store User Guide.

Find answers

Use the Mac User Guide
The Mac User Guide has a lot more information about how to use your MacBook Pro.

Get help. Go the the Tips App or click  in the Dock, then click the Help menu in the menu bar and
choose Mac User Guide. Type a question or term in the search field, then choose a topic from the results list.

https://support.apple.com/102106
help:openbook='com.apple.AppStore.help'


Explore topics. To find a topic in the Mac User Guide, you can browse or search. To browse, click “Table of
Contents” to see the list of topics, then click a topic to read it. Or type what you want to find in the search
field to go right to your answer.

Tip: If you can’t remember the location of a menu item in an app, search for it in Help. Place the pointer over
the result, and an arrow shows you the command.



Learn more. See the Mac User Guide.

Are you new to Mac?
If this is your first Mac computer, here is some helpful information to get you up to speed—especially if you
came from a Windows environment.

Familiarize yourself with the desktop. The desktop is where you do your work, and where you can quickly
open apps, search, and organize files.

help:openbook='com.apple.machelp'


On the desktop you’ll find:

The menu bar: The menu bar for the desktop or the active open app is always at the top of the screen.
Use menus to find options and perform tasks in apps. For information about items in the menu bar,
such as the Apple menu and the Help menu, see Desktop and menu bar on your Mac.

The Dock: The Dock is similar to the taskbar and Start menu in Windows and appears at the bottom of
the desktop (but you can change its location in System Settings). The Dock makes it easy to see all the
apps you have open and quickly launch your favorite apps. To open an app, click its icon in the Dock.
You can also open apps using Launchpad. See The Dock on your Mac.

The Finder: Click  in the Dock to open the Finder, where you organize and locate your files
(similar to File Explorer in Windows). Use the buttons at the top of the Finder window to change how

you view your files—as icons , in a list , in columns , or in a gallery . In any
view, you can select a file and press the Space bar to see a Quick Look preview without opening the
file. See Finder on your Mac.

The Spotlight menu: Spotlight lets you search for anything on your Mac, including documents,
contacts, email messages, and more. You can also launch apps and search on the web. To open

Spotlight, click  at the top right of the screen or press Command-Space bar. See Spotlight on your
Mac.



System Settings: System Settings  is similar to the Control Panel in Windows. Customize your
Mac with settings for the desktop, Dock, display, Bluetooth, network, and much more. See System
Settings on your Mac.

Get to know the keyboard and trackpad. The Command key  on Mac is generally the same as the
Control key on Windows. For example, use Command-C and Command-V to copy and paste content. The
Return key on Mac is the same as the Enter key on Windows, while the Delete key is the same as Backspace.
If you want to forward delete, Press Fn-Delete.

Use the trackpad to click, right-click, force click, scroll, swipe, and resize documents quickly. See
MacBook Pro trackpad for details on trackpad gestures.

For a list of Mac keyboard shortcuts and differences between Mac and Windows keyboards, see the Apple
Support article Mac tips for Windows switchers. Also see Windows keys on a Mac keyboard. For more
shortcuts in this guide, see Keyboard shortcuts on your Mac.

Install apps. You can download apps from the App Store or the internet. When you download an app from
the internet, you get a disk image file (ending in .dmg) or package file (.pkg). To install the app, locate the
.dmg or .pkg file in your Downloads folder, double-click it, then follow the onscreen instructions. You’re
prompted to delete the disk image or package file after you install the app.

To uninstall an app, find the app in the Applications folder in Finder, then drag the app to the Trash. Some
apps have an Uninstaller, which you can use to delete the app and other files associated with it. See Install
and uninstall apps.

Maximize, minimize, and close windows. You can have multiple windows for an app open at a time. Use
the buttons in the top-left corner of a window to resize and close windows.

Click  or press Command-W to close the window, but not the app. Press Option-Command-W to
close all open windows for the app. Press Command-Q to quit the app.

Click  to minimize a window (or press Command-M). Minimizing a window leaves the app open
but reduces the window to an icon on the right side of the Dock. Click the icon to restore the window to
its previous size.

Click  to open your app full-screen. To maximize the window, hold the Option key and click the
button. Or hold the pointer over the button to see more options, such as tiling the window. Press Esc to
return the window to its previous size.

Move windows. Drag the window by its title bar to put it where you want it. Some windows can’t be moved.
See Manage windows on Mac.

Switch between app windows. Press Command-Tab to quickly switch to the previous app. When you have
several app windows open, press and hold Command, then press Tab to see icons for all the open apps. While
holding Command, press Tab (or the arrow keys) to move between the apps and select the one you want to be
active. Release the Command key to work in the active app.

https://support.apple.com/102323
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Take a screenshot. Press Command-Shift-5 to access the Screenshot Utility. See Take a screenshot on your
Mac.

Let Siri do tasks for you. To activate Siri on your MacBook Pro, press and hold the Dictation/Siri key (F5).
If the option is turned on, you can say “Hey Siri” or “Siri” and continue with your request. Ask Siri to open a
folder, launch an app, make the screen brighter, and other tasks. See Siri on your Mac.

Use your Mac with iPhone, iPad, and Apple Watch. If you sign in to your Apple devices with the same
Apple Account, you can easily share files and photos, edit documents, answer email and calls, and send text
among devices. See Use iCloud with your MacBook Pro.

Learn more. See What’s it called on my Mac? and the Apple Support article Mac keyboard shortcuts.

Common questions about your Mac
How do I get support for my MacBook Pro? Go to MacBook Pro Support.

I’m new to Mac. Are there tips for PC users? Yes. See Are you new to Mac? and the Apple Support article
Mac tips for Windows switchers. You might also be interested in Keyboard shortcuts on your Mac.

How do I take a screenshot on my Mac? Press Command-Shift-3 to take a screenshot of the entire screen.
Press Command-Shift-4 to take a screenshot of a selected area of the screen. To learn more, see Take a
screenshot on your Mac.

Where is my serial number? Choose Apple menu   > About This Mac. The serial number is listed. You
can also find the serial number on the bottom of your MacBook Pro.

How do I know which model of MacBook Pro I have? See the Apple Support article Identify your

MacBook Pro model. You can also choose Apple menu   > About This Mac to view the model
information.

How can I find the documentation for my MacBook Pro? To find the MacBook Pro Getting Started Guide
guide, open System Settings, click the Help menu, then click User Manual. From the Help menu, you can
also click “macOS Help” to open the user guide for the operating system. For older Mac models, see Browse
manuals by product.

How do I get help for an app? When you’re using the app, click the Help menu in the menu bar at the top of
the screen.

Where is the safety information for my MacBook Pro? See Important safety information for your Mac.

How do I find the technical specifications? Open System Settings, click Help, then click MacBook Pro
Specifications.

How do I check my disk for problems? Use Disk Utility. See Repair a storage device in Disk Utility on
Mac.

How do I reinstall macOS? Use macOS Recovery. (The macOS Recovery process for MacBook Pro with
Apple silicon is different than the process for other MacBook Pro models.) See How to reinstall macOS.
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Note: Beginning with macOS Big Sur, Time Machine backups don’t include system files. See Back up and
restore your Mac.

How do I reinstall macOS? Use macOS Recovery. See the Apple Support article How to reinstall macOS.

Note: Beginning with macOS Big Sur, Time Machine backups don’t include system files. See Back up and
restore your Mac.

What should I do before selling or trading in my Mac? Back up your data, then restore your Mac to
factory settings. See What to do before you sell, give away, or trade in your Mac.

Keyboard shortcuts on your Mac
You can press key combinations to do things on your MacBook Pro that you’d normally do with a trackpad,
mouse, or other device. Here’s a list of commonly used keyboard shortcuts.

Note: Keyboard shortcuts in apps may vary depending on the language and keyboard layout you’re using on
your Mac. If the shortcuts below don’t work as you expect, look in the app menus in the menu bar to see the
correct shortcuts. You can also use the keyboard viewer to see your current keyboard layout, known as an
input source. See Use the keyboard viewer on Mac.

Shortcut Description
Command-X Cut the selected item and copy it to the Clipboard.
Command-C Copy the selected item to the Clipboard.
Command-V Paste the contents of the Clipboard into the current document or app.
Command-Z Undo the previous command. Press Command-Shift-Z to redo.
Command-A Select all items.
Command-F Open a Find window, or find items in a document.

Command-G Find the next occurrence of the item you’re searching for. Press Command-Shift-G to find
the previous occurrence.

Command-H Hide the windows of the front app. Press Command-Option-H to view the front app but
hide all other apps.

Command-M Minimize the front window to the Dock. Press Command-Option-M to minimize all
windows of the front app.

Command-N Open a new document or window.
Command-O Open the selected item, or open a dialog to select a file to open.
Command-P Print the current document.
Command-S Save the current document.
Command-W Close the front window. Press Command-Option-W to close all windows of the app.
Command-Q Quit the current app.
Command-
Option-Esc Choose an app to Force Quit.

Command-Tab Switch to the next most recently used app among your open apps.

Command-Shift-
5

Open the Screenshot utility. You can also take screenshots using the following shortcuts:

Press Command-Shift-3 to take a screenshot of the entire screen.

https://support.apple.com/102655
https://support.apple.com/102773
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Press Command-Shift-4 to take a screenshot of a selected area of the screen.

>> When writing in a note, creates a link to another note of your choice.

For more keyboard shortcuts, see the Apple Support article Mac keyboard shortcuts.

Security features for MacBook Pro
Your MacBook Pro with Apple silicon provides security features to protect what’s on your computer and
prevent unauthorized software apps from loading during startup:

Secure startup: Support for secure startup is turned on automatically. It’s designed to verify that the
operating system software loaded on your computer at startup is authorized by Apple.

If your MacBook Pro doesn’t start because it detects an untrusted component, it starts up from a secure
recovery partition and automatically corrects issues if possible. To learn how to set security options,
see Change security settings on the startup disk of a Mac with Apple silicon.

Secure storage: Your MacBook Pro storage drive is encrypted with hardware keys to provide advanced
levels of security. In the event of a catastrophic failure, data recovery may not be possible, so you need
to back up your files to an external source. See Use macOS Recovery on a Mac with Apple silicon.

You can set up Time Machine or another backup plan to regularly back up your files. See Back up your
files with Time Machine, and the Apple Support article Back up your Mac with Time Machine.

System integrity: The Apple silicon in your MacBook Pro is designed to verify that the version of
macOS software loaded during startup is authorized by Apple, and continues behind the scenes to
protect the authorizations established for macOS. This makes it harder for malware or malicious
websites to exploit your Mac.

Data Protection: In addition to the default storage drive encryption in MacBook Pro, third-party app
developers can use file-level encryption to better protect sensitive data, without impacting system
performance.

Connect accessories securely: With a MacBook Pro with Apple silicon, you can approve new USB and
Thunderbolt accessories when you connect them to your MacBook Pro. See Allow accessories to
connect to your Mac.

Note: In rare circumstances, such as a power failure during a macOS upgrade, your MacBook Pro may
become unresponsive and the firmware on the chip may need to be revived. See the Apple Support article
How to revive or restore Mac firmware.

Learn more. See the Apple Platform Security Guide.

Save space on your MacBook Pro
With Optimize Storage, you can automatically free up space on your MacBook Pro by making files available
on demand. Your oldest files are stored in iCloud and on your email IMAP or Exchange server, so you can
download them at any time. There are also tools to identify and delete big files.
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Optimize storage. To see storage recommendations, choose Apple menu   > System Settings, then click
General on the sidebar. Click Storage to see different recommendations based on how you configured your
Mac.

Set options to:

Store in iCloud: Store all files, photos, and messages in iCloud and save space on your Mac.

Desktop and Documents: Store all the files from your Desktop and Documents folders in
iCloud Drive. When storage space is needed, iCloud Drive keeps recently opened files on your
Mac and makes your oldest files available on demand.

Messages: Store all messages and attachments in iCloud. When storage space is needed, iCloud
keeps recent attachments on your Mac and makes your oldest files available on demand.

Even though your files are stored in the cloud, you can access them right where you left them on your
MacBook Pro. See Access your iCloud content on your Mac.

Optimize Storage: Save space on your Mac by optimizing the storage of movies and TV shows in the
Apple TV app. You can choose to automatically remove movies or TV shows from your MacBook Pro
after you watch them. You can download them again at any time.

Empty Trash automatically: Automatically erase items that have been in the Trash for more than 30
days.

To help you save space as you work, macOS also:

Prevents you from downloading the same file twice from Safari.

Alerts you to remove installer software when you finish installing a new app.

Clears logs and caches that are safe to remove when you’re low on storage.



Learn more. See Optimize storage space on your Mac.

Mac resources, service, and support
You can find more information about your MacBook Pro in System Report, in Apple Diagnostics, and
through online resources.

System Report. To get information about your MacBook Pro, use System Report. It shows you your
hardware model, the serial number and operating system version, how much memory is installed, and more.

To open System Report, choose Apple menu   > About This Mac, click More Info, then click System
Report.

Apple Diagnostics. You can use Apple Diagnostics to help determine if there’s a problem with one of the
computer’s components, such as the memory or processor. Apple Diagnostics helps to identify the potential
source of a hardware issue and provides first steps to try and resolve it. Apple Diagnostics also helps you get
in touch with AppleCare Support if you need more help.

Before using Apple Diagnostics, disconnect all external devices except keyboard, mouse, display, Ethernet
connection (if applicable), and connection to AC power. Be sure the computer is connected to the internet.

To start Apple Diagnostics, shut down your Mac, press and hold the power button until you see the startup
options window, then press and hold Command-D on your keyboard to enter diagnostics mode. If prompted,
select the language for your location. The basic Apple Diagnostics test takes a few minutes to complete. If an
issue is found, a description of the issue appears with additional instructions. Make a note of any reference
codes before you exit Apple Diagnostics, in case you need to contact AppleCare Support. See Use Apple
Diagnostics to test your Mac.

Online resources. For online service and support information, go to Welcome to Apple Support. You can
learn about Apple products, view online manuals, check for software updates, connect with other Apple
users, and get service, support, and professional advice from Apple. For more information about your
MacBook Pro, go to MacBook Pro Support.

AppleCare support. If you need assistance, AppleCare representatives can help you with installing and
opening apps, and with troubleshooting. Call the support center number nearest you (the first 90 days are
complimentary). Have the purchase date and your MacBook Pro serial number ready when you call.

A complete list of support telephone numbers is available on the web at Contact Apple for support and
service. Telephone numbers are subject to change, and local and national telephone rates may apply.

Your 90 days of complimentary telephone support begins on the date of purchase.

Safety, handling, and regulatory information

Important safety information for your Mac
WARNING: Failure to follow these safety instructions could result in fire, electric shock, or other injuries, or
damage to your MacBook Pro, cables, or other property. Read all safety information below before using your
MacBook Pro.

help:anchor='sysp4ee93ca4'%20bookID='com.apple.machelp'
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Built-in battery. Don’t attempt to replace or remove the battery yourself—you may damage the battery,
which could cause overheating and injury. The built-in battery should only be replaced or repaired by a
trained technician to avoid battery damage, which could cause overheating, fire, or injury. Repairs performed
by untrained individuals or using non-genuine Apple parts may affect the safety and functionality of the
device. The built-in battery must be recycled or disposed of separately from household waste. Dispose of
batteries according to your local environmental laws and guidelines. Don’t expose your MacBook Pro to
extreme heat sources, such as radiators or fireplaces, where temperatures might exceed 212°F (100°C).

For information about battery service and recycling, go to Battery Service and Recycling.

Handling. Handle your MacBook Pro with care. It is made of metal, glass, and plastic and has sensitive
electronic components inside. Place your MacBook Pro on a stable work surface that allows for adequate air
circulation under and around the computer. Your MacBook Pro can be damaged if dropped, burned,
punctured, or crushed, or if it comes in contact with liquids, oils, and lotions. Don’t use a damaged
MacBook Pro, such as one with a cracked screen, as it may cause injury.

Handle your USB-C to MagSafe 3 Cable with care. It contains sensitive electronic components inside.
Charge your device on a stable work surface that allows for adequate air circulation under and around the
computer. Your USB-C to MagSafe 3 Cable can be damaged if dropped, burned, punctured, or crushed, or if
it comes in contact with liquids, oils, and lotions. Don’t use a damaged or frayed USB-C to MagSafe 3 Cable.

Liquid exposure. Keep your MacBook Pro and its charge cable away from sources of liquid, such as drinks,
oils, lotions, sinks, bathtubs, shower stalls, and so on. Protect your MacBook Pro and the charge cable from
dampness, humidity, or wet weather, such as rain, snow, and fog.

Charging your MacBook Pro. Charge your MacBook Pro only with the included 70W USB-C Power
Adapter, 96W USB-C Power Adapter, or 140W USB-C Power Adapter and USB-C to MagSafe 3 Cable or
the 240W USB-C Charge cable (sold separately). You could also use a third-party power adapter and cable
that are compatible with USB-C PD and compliant with applicable international and regional regulations and
safety standards.

Other power adapters might not meet applicable safety standards, and charging with such power adapters
could pose a risk of death or injury. Using damaged power adapters or cables, or charging when moisture is
present, can cause fire, electric shock, injury, or damage to your MacBook Pro or other property. When you
use the included power adapter to charge your MacBook Pro, make sure the charge cable is fully inserted into
the power adapter before you plug the power adapter into a power outlet.

Prolonged heat exposure. Your MacBook Pro and its power adapter may become very warm during normal
use. The MacBook Pro and its 70W USB-C Power Adapter, 96W USB-C Power Adapter, or 140W USB-C
Power Adapter comply with required surface temperature limits defined by applicable country regulations
and international and regional safety standards. However, even within these limits, sustained contact with
warm surfaces for long periods of time may cause discomfort or injury.

To reduce the possibility of overheating or heat-related injuries, always allow adequate ventilation around the
MacBook Pro and its power adapter and use care when handling them. Use common sense to avoid situations
where your skin is in prolonged contact with a device or its power adapter when it’s operating or plugged into
a power source. For example, don’t sleep with a device or power adapter when it’s plugged into a power
source. Do not place the device or power adapter under a blanket, pillow, or your body when the device or
adapter is connected to a power source. Never push anything into the ventilation openings, as doing so may
be dangerous and cause your computer to overheat. Never place anything over the keyboard when operating
your MacBook Pro. If your MacBook Pro is on your lap and gets uncomfortably warm, remove it from your

https://www.apple.com/batteries/service-and-recycling


lap and place it on a stable, well-ventilated work surface. Take special care if you have a physical condition
that affects your ability to detect heat against the body.

70W USB-C Power Adapter, 96W USB-C Power Adapter, or 140W USB-C Power Adapter. To operate
the 70W USB-C Power Adapter, 96W USB-C Power Adapter, or 140W USB-C Power Adapter safely and
reduce the possibility of heat-related injury or damage, do one of the following:

Plug the 70W USB-C Power Adapter, 96W USB-C Power Adapter, or 140W USB-C Power Adapter
directly into a power outlet.

If you’re using the Power Adapter Extension Cable, place the power adapter on a desk, table, or on the
floor in a well-ventilated location.

Don’t use your MacBook Pro or its power adapter in wet locations, such as near a sink, bathtub, or shower
stall, and don’t connect or disconnect the power adapter with wet hands. Unplug the power adapter and
disconnect any cables if any of the following conditions exists:

The USB-C cable or power cord has become frayed or damaged.

The plug part of the 70W USB-C Power Adapter, 96W USB-C Power Adapter, or 140W USB-C Power
Adapter, the prongs, or the adapter case have become damaged.

Your MacBook Pro or 70W USB-C Power Adapter, 96W USB-C Power Adapter, or 140W USB-C
Power Adapter has been dropped.

Your MacBook Pro or 70W USB-C Power Adapter, 96W USB-C Power Adapter, or 140W USB-C
Power Adapter is exposed to rain, liquid, or excessive moisture.

You suspect the MacBook Pro or 70W USB-C Power Adapter, 96W USB-C Power Adapter, or 140W
USB-C Power Adapter needs service or repair.

You want to clean the MacBook Pro or 70W USB-C Power Adapter, 96W USB-C Power Adapter, or
140W USB-C Power Adapter (use only the recommended procedure, described in Important handling
information for your Mac).

The MagSafe 3 power port contains a magnet that can erase data on a credit card, iPod, or other device. To
preserve your data, do not place these or other magnetically sensitive material or devices within 1 inch (25
mm) of this port.

If debris gets onto the power port, remove it gently with a dry cotton swab.

70W USB-C Power Adapter specifications:

Frequency: 50 to 60 Hz, single phase

Line Voltage: 100 to 240 V

(USB-PD) Output Voltage: 5VDC/3A or 9VDC/3A or or 15VDC/3A or 20.6VDC/3.4A

96W USB-C Power Adapter specifications:

Frequency: 50 to 60 Hz, single phase



Line Voltage: 100 to 240 V

(USB-PD) Output Voltage: 20.5VDC/4.7A or 15VDC/3A or 9VDC/3A or 5.2VDC/3A

140W USB-C Power Adapter specifications:

Frequency: 50 to 60 Hz, single phase

Line Voltage: 100 to 240 V

(USB-PD) Output Voltage: 28VDC/5A or 20.5VDC/5A or 15VDC/5A or 9VDC/3A or 5.2VDC/3A

Liquid exposure. Keep your away from sources of liquid, such as drinks, oils, lotions, washbasins, bathtubs,
shower stalls, and so on. Protect your from dampness, humidity, or wet weather, such as rain, snow, and fog.

Hearing loss. Listening to sound at high volumes may damage your hearing. Background noise, as well as
continued exposure to high volume levels, can make sounds seem quieter than they actually are. Use only
compatible earbuds, headphones, or earpieces with your MacBook Pro. Turn on the audio and check the
volume before inserting anything into your ear. See Sound and Hearing.

WARNING: To prevent possible hearing damage, do not listen at high volume levels for long periods.

Repairing. Your MacBook Pro should only be serviced by a trained technician. Disassembling your
MacBook Pro may damage it or may cause injury to you. If you attempt to open your MacBook Pro, you risk
damaging your computer, and such damage isn’t covered by the limited warranty on your MacBook Pro. If
your MacBook Pro is damaged or malfunctions, you should contact Apple or an Apple Authorized Service
Provider for service. Repairs performed by untrained individuals or using non-genuine Apple parts may affect
the safety and functionality of the device. You can find information about repairs and service at Mac Repair
and Service.

Navigation. Maps, directions, and location-based apps depend on data services. These data services are
subject to change and may not be available in all areas, resulting in maps, directions, or location-based
information that may be unavailable, inaccurate, or incomplete. Compare the provided location-based
information to your surroundings and defer to posted signs to resolve any discrepancies. Do not use these
services while performing activities that require your full attention. Always comply with posted signs and the
applicable laws and regulations in the areas where you are using navigation, and always use common sense.

Radio frequency exposure. MacBook Pro uses radio signals to connect to wireless networks. For
information about radio frequency (RF) energy resulting from radio signals and steps you can take to
minimize exposure, go to RF Exposure.

Medical device interference. MacBook Pro contains magnets, as well as components and radios that emit
electromagnetic fields. These magnets and electromagnetic fields might interfere with medical devices.
Consult your physician and medical device manufacturer for information specific to your medical device, and
whether you need to maintain a safe distance of separation between your medical device and MacBook Pro.
Manufacturers often provide recommendations on the safe use of their devices around wireless or magnetic
products to prevent possible interference. If you suspect MacBook Pro is interfering with your medical
device, stop using your MacBook Pro. Medical devices such as implanted pacemakers and defibrillators may
contain sensors that respond to magnets and radios when in close contact. To avoid any potential interactions
with these devices, keep your MacBook Pro a safe distance away from your device (more than 6 inches / 15
cm), but consult with your physician and your device manufacturer for specific guidelines.

https://www.apple.com/sound/
https://support.apple.com/mac/repair/service
https://www.apple.com/legal/rfexposure


Medical conditions. If you have a medical condition that you believe could be affected by using
MacBook Pro (for example, seizures, blackouts, eyestrain, or headaches), consult with your physician prior to
using MacBook Pro.

Repetitive motion. When you perform repetitive activities such as typing or playing games on
MacBook Pro, you may experience discomfort in your hands, arms, wrists, shoulders, neck, or other parts of
your body. If you experience discomfort, stop using MacBook Pro and consult a physician.

Choking hazard. Some MacBook Pro accessories may present a choking hazard to small children. Keep
these accessories away from small children.

High-consequence activities. Your MacBook Pro is not intended for use where the failure of the computer
could lead to death, personal injury, or severe environmental damage.

Explosive and other atmospheric conditions. Using MacBook Pro in any area with a potentially explosive
atmosphere may be hazardous—particularly in areas where the air contains high levels of flammable
chemicals, vapors, or particles such as grain, dust, or metal powders. Exposing MacBook Pro to
environments having high concentrations of industrial chemicals, including evaporating liquified gases such
as helium, may damage or impair MacBook Pro functionality. Obey all signs and instructions.

For Australian customers, see the Online Safety resources website.

Important handling information for your Mac
Operating environment. Operating your MacBook Pro outside these ranges may affect performance:

Operating temperature: 50° to 95° F (10° to 35° C)

Storage temperature: -13° to 113° F (-25° to 45° C)

Relative humidity: 0% to 90% (noncondensing)

Operating altitude: Tested up to 10,000 feet (0 to 3048 meters)

Carrying your MacBook Pro. If you carry your MacBook Pro in a bag or briefcase, make sure there are no
loose items (such as paper clips or coins) that could accidentally get inside the computer through vent
openings or get stuck inside a port.

CAUTION: Keep hands and fingers away from the moving parts to avoid pinching.

Using connectors and ports. Never force a connector into a port. Before you plug the power cord into the
power port, make sure the power port is completely free of debris. When connecting a device to a port, make
sure the port is completely free of debris, that the connector matches the port, and that you have positioned
the connector correctly in relation to the port.

Important: Use only the original cables that came with your computer or accessory, or cables sold at an
Apple retail store or online at apple.com.

Using the USB-C to MagSafe 3 Cable (2 m). Certain usage patterns can contribute to the fraying or
breaking of cables. The USB-C to MagSafe 3 Cable, pictured in What’s included with your MacBook Pro,
like any other metal wire or cable, is subject to becoming weak or brittle if repeatedly bent in the same spot.

https://www.apple.com/au/legal/online-safety/
https://www.apple.com/


Aim for gentle curves instead of angles in the cable. Regularly inspect the cable and connectors for any kinks,
breaks, bends, or other damage. Should you find any such damage, discontinue use of the USB-C to MagSafe
3 Cable.

Using the 240W USB-C Charge Cable (sold separately). Certain usage patterns can contribute to the
fraying or breaking of cables. The 240W USB-C Charge Cable, like any other metal wire or cable, is subject
to becoming weak or brittle if repeatedly bent in the same spot. Aim for gentle curves instead of angles in the
cable. Regularly inspect the cable and connectors for any kinks, breaks, bends, or other damage. Should you
find any such damage, discontinue use of the 240W USB-C Charge Cable.

Storing your MacBook Pro. If you’re going to store your MacBook Pro for an extended period of time,
keep it in a cool location (ideally, 71° F or 22° C) and discharge the battery to 50 percent. When storing your
computer for longer than five months, maintain the capacity of the battery by charging the battery to 50
percent every six months or so.

Cleaning your MacBook Pro. When cleaning the outside of your MacBook Pro and its components, first
shut down your MacBook Pro and unplug the charge cable and the power adapter. Then dampen a clean, soft,
lint-free cloth to wipe the MacBook Pro exterior. Avoid getting moisture in any openings. Don’t spray liquid
directly on the computer. Don’t use aerosol sprays, solvents, abrasives, or cleaners containing hydrogen
peroxide, which might damage the finish.

Cleaning the MacBook Pro screen. To clean the MacBook Pro screen, first shut down your MacBook Pro
and unplug the charge cable and the power adapter. Then dampen a clean, soft, lint-free cloth with just water
and wipe the screen. Don’t spray liquid directly on the screen.

Mac ergonomics
When you use the keyboard and mouse, your shoulders should be relaxed. Your upper arm and forearm
should form an angle that is slightly greater than a right angle, with your wrist and hand in roughly a straight
line.

Use a light touch when typing or using the trackpad and keep your hands and fingers relaxed. Avoid rolling
your thumbs under your palms.



Change hand positions often to avoid fatigue. Some computer users might develop discomfort in their hands,
wrists, or arms after intensive work without breaks. If you begin to develop chronic pain or discomfort in
your hands, wrists, or arms, consult a qualified health specialist.

Mouse or optional trackpad. Position the mouse or trackpad at the same height as the keyboard and within
a comfortable reach.

Chair. An adjustable chair that provides firm, comfortable support is best. Adjust the height of the chair so
your thighs are horizontal and your feet are flat on the floor. The back of the chair should support your lower
back (lumbar region). Follow the manufacturer’s instructions for adjusting the backrest to fit your body
properly.

Built-in display. Adjust the angle of the display to minimize glare and reflections from overhead lights and
windows. Do not force the display if you meet resistance. The display is not designed to open past 135
degrees.

You can adjust the brightness of the screen when you take the computer from one work location to another, or
if the lighting in your work area changes.

For more information about ergonomics, see the Apple Support article Ergonomics.

Regulatory information
Regulatory information, certification, and compliance marks specific to MacBook Pro are available on-

device. Choose Apple menu   > About This Mac, then click Regulatory Certification.

FCC compliance statement
This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1)
this device may not cause harmful interference, and (2) this device must accept any interference received,
including interference that may cause undesired operation.

Note: This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference in a residential installation.

This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in
accordance with the instructions, may cause harmful interference to radio communications. However, there is
no guarantee that interference will not occur in a particular installation.

https://www.apple.com/about/ergonomics


If this equipment does cause harmful interference to radio or television reception, which can be determined
by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more
of the following measures:

Reorient or relocate the receiving antenna.

Increase the separation between the equipment and receiver.

Connect the equipment to an outlet on a circuit different from that to which the receiver is connected.

Consult the dealer or an experienced radio/TV technician for help.

Changes or modifications to this product not authorized by Apple could void the electromagnetic
compatibility (EMC) and wireless compliance and negate your authority to operate the product.

This product has demonstrated EMC compliance under conditions that included the use of compliant
peripheral devices and shielded cables between system components. It is important that you use compliant
peripheral devices and shielded cables between system components to reduce the possibility of causing
interference to radios, television sets, and other electronic devices.

The operation of this device is prohibited on oil platforms and aircraft, except that operation of this device in
5.925-6.425 GHz is permitted in large aircraft while flying above 10,000 feet.

Installation on outdoor fixed infrastructure is prohibited.

Operation of transmitters in the 5.925-7.125 GHz is prohibited for control of or communications with
unmanned aircraft systems.

Responsible party (contact for FCC matters only):

Apple Inc.

One Apple Park Way, MS 911-AHW

Cupertino, CA 95014

USA

apple.com/contact

ISED Canada compliance statement
This device complies with ISED Canada licence-exempt RSS standard(s). Operation is subject to the
following two conditions: (1) this device may not cause interference, and (2) this device must accept any
interference, including interference that may cause undesired operation of the device.

Operation in the band 5150–5250 MHz is only for indoor use to reduce the potential for harmful interference
to co-channel mobile satellite systems.

Operation in 5925-7125 MHz band shall not be used for control of or communications with unmanned
aircraft systems.

https://www.apple.com/contact


Le présent appareil est conforme aux CNR d’ISDE Canada applicables aux appareils radio exempts de
licence. L’exploitation est autorisée aux deux conditions suivantes : (1) l’appareil ne doit pas produire de
brouillage, et (2) l’appareil doit accepter tout brouillage radioélectrique subi, même si le brouillage est
susceptible d’en compromettre le fonctionnement.

La bande 5150–5250 MHz est réservée uniquement pour une utilisation à l’intérieur afin de réduire les
risques de brouillage préjudiciable aux systèmes de satellites mobiles utilisant les mêmes canaux.

Les appareils dans la bande 5925-7125 MHz ne doivent pas être utilisés pour contrôler des systèmes
d’aéronefs sans pilote ou pour communiquer avec de tels systèmes.

ENERGY STAR® compliance statement

As an ENERGY STAR partner, Apple has determined that standard configurations of this product meet the
ENERGY STAR guidelines for energy efficiency. The ENERGY STAR program is a partnership with
electronic equipment manufacturers to promote energy-efficient products. Reducing energy consumption of
products saves money and helps conserve valuable resources.

MacBook Pro is shipped with power management enabled, with the computer set to sleep after 10 minutes of
user inactivity. To wake your computer, click the trackpad or press any key on the keyboard. To change this
setting, open System Settings, then click Lock Screen.

MacBook Pro meets the ENERGY STAR guidelines for energy efficiency. For more information about
ENERGY STAR, go to the Energy Star website.

Apple and the environment
At Apple, we recognize our responsibility to minimize the environmental impacts of our operations and
products.

For information, go to Apple’s Environment website.

Disposal and recycling information

The symbol above means that according to local laws and regulations your product and/or its battery shall be
disposed of separately from household waste. When this product reaches its end of life, take it to a collection
point designated by local authorities. The separate collection and recycling of your product and/or its battery
at the time of disposal will help conserve natural resources and ensure that it is recycled in a manner that
protects human health and the environment.

For information about Apple’s recycling program, recycling collection points, restricted substances, and other

https://www.energystar.gov/
https://www.apple.com/environment


environmental initiatives, visit apple.com/environment.

Información sobre eliminación de residuos y reciclaje

El símbolo de arriba indica que este producto y/o su batería no deben desecharse con los residuos domésticos.
Cuando quieras desechar este producto y/o su batería, hazlo de conformidad con las leyes y directrices
medioambientales locales. Para obtener más información sobre el programa de reciclaje de Apple, los puntos
de recolección para reciclaje, las sustancias restringidas y otras iniciativas medioambientales, visita
apple.com/mx/environment o apple.com/la/environment.

Brasil – Informações sobre descarte e reciclagem

O símbolo acima indica que este produto e/ou sua bateria não devem ser descartados no lixo doméstico.
Quando decidir descartar este produto e/ou sua bateria, faça-o de acordo com as leis e diretrizes ambientais
locais. Para informações sobre substâncias de uso restrito, o programa de reciclagem da Apple, pontos de
coleta e telefone de informações, visite apple.com/br/environment.

Apple Recycling Program

For free recycling of your old device, a prepaid shipping label, and instructions, see Apple Trade In website.

Note: The Apple Recycling program is not available in all countries and regions.

Turkey environmental information

Türkiye Cumhuriyeti: AEEE Yönetmeliğine Uygundur.

Battery disposal information

The battery in your MacBook Pro should be serviced, replaced, or recycled by Apple or an authorized service
provider, and must be recycled or disposed of separately from household waste according to your local
environmental laws and guidelines. For information about battery service and recycling, go to Battery Service
and Recycling.

Software License Agreement
Use of MacBook Pro constitutes acceptance of the Apple and third-party software license terms found at
Software License Agreements.

Copyright
Copyright © 2024 Apple Inc. All rights reserved.

Use of the “keyboard” Apple logo (Option-Shift-K) for commercial purposes without the prior written
consent of Apple may constitute trademark infringement and unfair competition in violation of federal and
state laws.

Apple, the Apple logo, Apple Studio Display, AirDrop, AirPlay, AirPods, AirTag, Apple Books, Apple Card,

https://www.apple.com/environment
https://www.apple.com/mx/environment/
https://www.apple.com/la/environment
https://www.apple.com/br/environment
https://www.apple.com/shop/trade-in
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https://www.apple.com/legal/sla


Apple Music, Apple Pay, Apple Pencil, Apple Podcasts, Apple Pro Display XDR, Apple TV, Apple Wallet,
Apple Watch, Face ID, FaceTime, FileVault, Find My, Finder, Freeform, GarageBand, Handoff, HomeKit,
HomePod, iMessage, iMovie, iPad, iPadOS, iPhone, iPod, iPod touch, Keychain, Keynote, Launchpad,
Lightning, Live Photos, Mac, MacBook Pro, macOS, Magic Keyboard, MagSafe, Memoji, Mission Control,
Night Shift, Numbers, Pages, Retina, Safari, Sidecar, Siri, Spotlight, Stage Manager, Time Machine,
Touch ID, True Tone, and tvOS are trademarks of Apple Inc., registered in the U.S. and other countries and
regions.

Center Stage, Force Touch, and SharePlay are trademarks of Apple Inc.

App Store, Apple Arcade, AppleCare, Apple News, Apple One, iCloud, iCloud+, iCloud Drive, iCloud
Keychain, and iTunes Store are service marks of Apple Inc., registered in the U.S. and other countries and
regions.

Apple

One Apple Park Way

Cupertino, CA 95014

apple.com

IOS is a trademark or registered trademark of Cisco in the U.S. and other countries and is used under license.

The Bluetooth® word mark and logos are registered trademarks owned by Bluetooth SIG, Inc. and any use of
such marks by Apple Inc. is under license.

ENERGY STAR and the ENERGY STAR mark are registered trademarks owned by the U.S. Environmental
Protection Agency.

Other company and product names mentioned herein may be trademarks of their respective companies.

Every effort has been made to ensure that the information in this manual is accurate. Apple is not responsible
for printing or clerical errors.

Some apps are not available in all areas. App availability is subject to change.

Copyright © 2024 Apple Inc. All rights reserved.

Use of the “keyboard” Apple logo (Option-Shift-K) for commercial purposes without the prior written
consent of Apple may constitute trademark infringement and unfair competition in violation of federal and
state laws.

Apple, the Apple logo, Apple Studio Display, AirDrop, AirPlay, AirPods, AirTag, Apple Books, Apple Card,
Apple Music, Apple Pay, Apple Pencil, Apple Podcasts, Apple Pro Display XDR, Apple TV, Apple Wallet,
Apple Watch, Face ID, FaceTime, FileVault, Find My, Finder, Freeform, GarageBand, Handoff, HomeKit,
HomePod, iMessage, iMovie, iPad, iPadOS, iPhone, iPod, iPod touch, Keychain, Keynote, Launchpad,
Lightning, Live Photos, Mac, MacBook Pro, macOS, Magic Keyboard, MagSafe, Memoji, Mission Control,
Night Shift, Numbers, Pages, Retina, Safari, Sidecar, Siri, Spotlight, Stage Manager, Time Machine,
Touch ID, True Tone, and tvOS are trademarks of Apple Inc., registered in the U.S. and other countries and
regions.
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Center Stage, Force Touch, and SharePlay are trademarks of Apple Inc.

App Store, Apple Arcade, AppleCare, Apple News, Apple One, iCloud, iCloud+, iCloud Drive, iCloud
Keychain, and iTunes Store are service marks of Apple Inc., registered in the U.S. and other countries and
regions.

Apple

One Apple Park Way

Cupertino, CA 95014

apple.com

IOS is a trademark or registered trademark of Cisco in the U.S. and other countries and is used under license.

The Bluetooth® word mark and logos are registered trademarks owned by Bluetooth SIG, Inc. and any use of
such marks by Apple Inc. is under license.

ENERGY STAR and the ENERGY STAR mark are registered trademarks owned by the U.S. Environmental
Protection Agency.

Other company and product names mentioned herein may be trademarks of their respective companies.

Every effort has been made to ensure that the information in this manual is accurate. Apple is not responsible
for printing or clerical errors.

Some apps are not available in all areas. App availability is subject to change.
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